
Research Article

Journal of Communicable Diseases (P-ISSN: 0019-5138 & E-ISSN: 2581-351X)
Copyright (c) 2019: Advanced Research Publications

Journal of Communicable Diseases
Volume 51, Issue 4 - 2019, Pg. No. 16-20
Peer Reviewed & Open Access Journal

Corresponding Author: 
Neeta Raj Sharma, School of Bioengineering 
and Biosciences, Lovely Professional University, 
Phagwara, India.
E-mail Id:
neeta.raj@lpu.co.in
Orcid Id:
https://orcid.org/0000-0001-8638-4217
How to cite this article:
Bansal A, Sharma NR, Upadhyay AK, Kaushik 
S, Thomas TG. Evaluation of Carvacrol and its 
Receptor (Ubiquinone-c-reductase) as a Potential 
Anti-malarial Drug. J Commun Dis 2019; 51(4): 
16-20.

Date of Submission: 2019-10-23
Date of Acceptance: 2020-02-01

I N F O A B S T R A C T

Evaluation of Carvacrol and its Receptor 
(Ubiquinone-c-reductase) as a Potential 
Anti-malarial Drug
Anu Bansal1, Neeta Raj Sharma2, Atul K Upadhyay3, Shweta Kaushik4, TG Thomas5

1,2,3School of Bioengineering and Biosciences, Lovely Professional University, Phagwara, India.
4,5National Centre for Disease Control, 22-Sham Nath Marg, Delhi, India.
DOI: https://doi.org/10.24321/0019.5138.201932

In recent times natural products are exploiting for its medicinal 
properties due to its minimum side-effects. Carvacrol which is one 
of the monoterpene’s isolated from the essential oil of Oreganum 
vulgare possesses various antimicrobial, anti-oxidant and anti-cancerous 
activities. Therefore, in this present study carvacrol was selected to study 
its anti-malarial activity. A comparative study of commercially available 
drugs (Malarone) and carvacrol was conducted to understand the 
putative mechanism of action of carvacrol and its potential as a natural 
anti-malarial drug. Way2drug tool was used to predict the biological 
activity of the compound using the PASS Online server to predict the 
target protein of carvacrol. Further, Ubiquinone-c-reductase was selected 
for molecular docking with carvacrol because Malarone cures malaria 
by inhibiting the activity of enzyme. Ubiquinone-c-reductase is the 
key enzyme of the electron transport chain. It resulted that the amino 
acids positioned at 264-267 in chain ‘A’ of ubiquinone-c-reductase, 
were efficiently targeted by carvacrol with a minimum energy value of 
-5.4 Kcal/ mol. The present study resulted that carvacrol behaves as a 
natural blocker for ub-c-reductase may serve as a possible mechanism 
to develop carvacrol as a potential herbal anti-malarial drug. 
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Introduction
Malaria is one of the infectious diseases affecting 
humans caused by parasite namely Plasmodium type. 
Out of all types, Plasmodium falciparum is one of the 
major parasites causing deaths due to malaria. Female 
Anopheles mosquito acts as a vector for the parasite to 
human blood. Further, from the blood, parasite reaches 
to liver for its maturation and reproduction. After replica, 
the parasite enters in erythrocyte, de-differentiates, 

replicates the DNA and thereby infects RBCs. P. falciparum 
itself shows less activity of the Electron Transport Chain 
(ETC) pathway thereby used the host ETC pathway of 
erythrocyte for synthesizing pyrimidine and transfer of 
an electron from cytochrome c reductase to cytochrome 
c.7 Various studies have demonstrated that inhibitors of ETC 
pathway can be targeted to design antimalarial drug.8 The 
prevalent antimalarial drug commercialized is Malarone, 
a combination of atovaquone and proguanil used to treat 
and cure malaria.1 Atovaquone is the analog of ubiquinone 
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and thereby inhibits the cytochrome-c-reductase activity 
in the intra-erythrocyte parasitic ETC pathway.4 It disturbs 
the membrane potential of mitochondria, further causes 
collapsing, damaging and death of cells. It has been 
studied that atovaquone is responsible for the parasite 
death due to the indirect inhibition of dihydroorotate 
dehydrogenase, which requires the ETC pathway and is 
essential to pyrimidine biosynthesis.11 Proguanil is used in 
combination with atovaquone as another antimalarial drug. 
It gets converted to its active form cycloguanil, as it enters 
inside the liver (Tablets). Cycloguanil inhibits the activity 
of the enzyme dihydrofolate reductase, which catalyzes 
the conversion of dihydrofolate to Tetrahydrofolate (THF).2

However, some findings report adverse effects of using 
Malarone such as coughing, diarrhea, nausea, vomiting or 
headache. These days, natural products are preferred as 
they have more advantages with minimum adverse effects. 
In this study antimalarial activity of carvacrol is reported. 
Carvacrol is one of the secondary metabolites extracted 
from the essential oil of Oreganum vulgare. It is synthesized 
by the Mevalonic acid pathway, which occurs in the cytosol 
of plant cells. Acetyl-CoA is a precursor of this pathway 
and the products are Isopentenyl Pyrophosphate (IPP) and 
Dimethylallyl Pyrophosphate (DMAPP).5 DMAPP undergoes 
condensation with IPP to synthesize Geranyl diphosphate 
(GPP) in the presence of enzyme prenyltransferase. These 
GPP undergo cyclization catalyzed by terpene synthase in 
order to yield terpenoid compound.6 The main enzyme 
involved in the synthesis of carvacrol in Oreganum vulgare 
is terpene synthase.6 This study is focused on predicting 
the potential target of carvacrol to inhibit the growth of 
Plasmodium falciparum using the Way2drug tool. This 
bioinformatics tool helps in identifying the most probable 
new lead molecule with specific biological activity. It predicts 
biological activities based on the molecular structure of 
the compound.13 Probable value P=1/n ∑Pa/(Pa+Pi) is used 
to predict the activity of any compound and significant P 
value showed the compound with the highest biological 
potential. A comparative analysis has been done among 
carvacrol and constituents of commercialized antimalarial 
drug Malarone to evaluate the applicability of carvacrol as 
an effective drug.

To study the molecular binding of carvacrol with the 
potential receptor, molecular docking is done using the 
Autodock standalone tool. The tool used in the study 
Auto dock 4 was developed by Morris GM et al. after its 
first release in 1990.11 This tool enables us to perform 
the docking of a macromolecule with the ligand which 
performs efficiently by foretelling binding conformations 
and binding energies between macromolecule and ligand 
under consideration. This program performs by initially 
looking for hefty conformational space for the ligand in the 
region of protein which is carried out by Lamarckian genetic 

algorithm.9 The auto dock uses a grid-based method for the 
calculation of binding energies of the conformations. In this 
approach, the target macromolecule is entrenched in a grid 
after which the investigative atom is placed chronologically 
in each grid point and their respective binding energy is 
noted in each grid. This binding energy is used later during 
the docking imitation. This tool also allows the user to carry 
out a simulated annealing search and traditional genetic 
algorithm search.10 In the present study, effort has been 
made to study the efficacy of the natural herbal molecule in 
comparison to commercially available anti-malarial drugs.

Materials and Methods
Prediction of Anti-malarial Activity

Bioinformatics tool http://way2drug.com/ is available to 
predict the biological activity of the compound. It provides 
access to the PASS Online server to obtain the predicted 
biological activity, mechanism of action of the selected 
compound. 

Installation of the Tools

The latest available version of the AutoDock was 
downloaded from http://autodock.scripps.edu/downloads/
autodock-registration/autodock-4-2-download-page/ for 
the windows. The program was installed in the default 
directory C:\Program Files (x86)\.

Retrieval of the Macromolecule and Ligand

The macromolecule used in the study was ub-c reductase. 
This macromolecule was docked with the ligand carvacrol 
with the help of autodock4. As the tools read pdb file format 
of the macromolecule and ligand thus the 3D structure of 
ub-c reductase was retrieved from https://www.rcsb.org/
in pdb format. The structure of the ub-c reductase is stored 
under the PDB ID: 5XTE. Similarly, carvacrol structure was 
retrieved from https://pubchem.ncbi.nlm.nih.gov in the sdf 
format which was then converted to pdbqt format by using 
Open Babel12. Finally, both the pdb and pdbqt files of the 
macromolecule and ligand were saved under C:\workspace.

Setting up the Macromolecule

While performing the analysis under mention protocol 
was followed:

Initially open the ub_c_reductase.pdb file in the text editor. 
Furthermore, A and B chain atom line was selected and 
stored as a newly edited file as “ub_c_reductase_a_b_
chain” followed by its docking.

The autoDock tool was opened by clicking on its desktop 
shortcut. Under the main menu the path used was: click 
File> Read Molecule> browse the workspace Folder > select 
the macromolecule file named as ub_c reductase_a_b_
chain.pdb > click open. Removed water by Edit> click on 
Delete Water option. Hydrogen atoms were added to the 
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macromolecule by Edit > Hydrogens > add > All Hydrogens 
> ok option. Non-Polar hydrogen were merged by Edit > 
Hydrogen > Merge Non-Polar, then Click Edit > Charges 
> Compute Gasteiger > Total Gasteiger charge added = 
-14.9962 > Click ok and saved the file using pathway File 
> Save > Write pdb > Ok which writes the newly modified 
pdb file to the workspace folder. Then after, clicked on Grid 
> Macromolecule > choose > select macromolecule > ok 
> saved as “protein.pdbqt” in the same folder containing 
the pdb files.

Setting up the Ligand

In AutoDock clicked on Ligand > input > open > select 
ligand file “carvacrol.pdbqt” > open AutoDock automatically 
modified the ligand in terms of addition of charges and also 
detects the frequency of rotatable bonds in the ligand. In 
this case, 6 aromatic carbons were found in the ligand and 
one rotatable bond was detected. TORSDOF was set to 1 
automatically with respect to detected rotatable bonds. 
Further, clicked on Ligand > Torsion Tree> Detect root 
option wherein root was indicated by the green circle in 
the Autodock visualization window.

Setting Grid Space

At this point boundary of the grid box for macromolecule 
was set under which the ligand was studied for its potential 
binding. To study the grid space setting, clicked on Grid > 
Macrolecule > Choose > Select the file ub_c_reductase_a_b_
chain.pdb > saved the modified macromolecule in pdbqt 
extension in the same workspace destination. Further, for 
ligand, clicked on Grid > Set map types > choose ligand > 
select carvacrol > click ligand options and clicked on Grid 
> Grid Box finally.12 The following values were entered to 
set the grid box as shown in Figure 1.

X center=51.019

Y center=92.826

Z center=94.059

Number of points in x dimension=92

Table 1.Predicted biological activity of (A) carvacrol 
and (B) atovaquone, selected Pa>Pi where Pa is 

the probability of the compound being active for a 
particular activity and Pi is the probability of inactive

Pa Pi Activity

0.931 0.004 Ubiquinol-cytochrome-c reductase 
inhibitor

0.908 0.001 SULT1A3 substrate
0.898 0.003 Antiseptic
0.888 0.003 Alkane 1-monooxygenase inhibitor
0.884 0.002 Carminative

Pa Pi Activity

0.775 0.041 Ubiquiol-cytochrome-c reductase 
inhibitor

0.730 0.010 27-Hydroxycholesterol 7alpha-
monooxygenase inhibitor

0.734 0.014 Aldehyde oxidase inhibitor
0.759 0.046 CYP2C12 substrate
0.717 0.011 CYP2C9 substrate

Table 2.Binding energy and RMSD value of 10 
conformations obtained after AutoDock

Bound 
conformation

Number

Binding 
energy

(Kcal/mol)

Distance from finest 
bound conformation

RMSD Lower Bound

1 -5.4 0.000

2 -5.3 0.479

3 -5.3 22.504

4 -5.1 22.059

5 -5.1 36.325

6 -5.0 30.695

7 -4.9 20.552

8 -4.6 21.551

9 -4.6 8.153

Figure 1.Carvacrol and ubiquinone-c-reductase 
docked conformation with the lowest binding energy

Figure 2.Conformation depicting distance between the 
carvacrol and binding site of ubiquinol-c-reductase
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Number of points in y dimension=74

Number of points in z dimension=94

Spacing=1.000 angstrom

Clicked on File > Close saving current option. Clicked on 
Grid > output > save gpf > give file name “grid.gpf” > save 
to the workspace folder.

Performing Autogrid

To perform auto grid the option selected was Run > Run 
Autogrid > Autogrid which was further followed by the 
selection of path under the provided options in the Autogrid 
window.

Program Pathname=C:/Program Files (x86)/MGLTools 
-1.5.6/4.2.6/autogrid4.exe

Parameter Filename=C:/workspace/grid.gpf

Log File Name=C:/workspace/grid.glg (automatically write 
while the parameter filename path was added) shown in 
figure 1. To launch the autogrid clicked Launch option and 
AutoDock process manager for the window to appear. On 
the successful completion, the process manager window 
disappeared.

Performing Autodock

Docking is performed absolutely by means of several search 
strategies. The best approach is the Lamarck genetic set of 
rules (LGA), however, it’s far traditional genetic algorithms 
and simulated annealing are also available. For traditional 
structures, AutoDock starts over and over to give extra 
anchored conformations and examine the anticipated 
power and the consistency of the results. Autodock analysis 
was done after complete run.

Result
Prediction of Anti-Malarial Activity

Comparative evaluation of biological efficiency of 
Atovaquone and Carvacrol was conducted using Pass Online 
software and the results obtained were shown in table 1.

Atovaquone showed Pa-value 0.775 (where Pa value is 
the probability of the compound being active for specific 
activity) as Ubiquinol-c-reductase inhibitor which is less than 
the Pa value of Carvacrol (Pa-value=0.931). The obtained 
data revealed that the Carvacrol inhibits the activity of 
Ubiquinol-cytochrome-c reductase more effectively as 
compared to Atovaquone with Pa value of 0.931 which is 
also the target receptor of commercialized drug Malarone.

Molecular Docking

After predicting the receptor of Carvacrol, docking of 
the ubiquinone-c-reductase with ligand Carvacrol was 
performed by using AutoDock, in return on accessing 
the option in AutoDock “Play ranked by energy” it was 

observed that the entire conformation of Carvacrol docked 
with Ubquinone-c-reductase in accordance with their free 
binding energies. A total of 9 docked conformations were 
returned by the AutoDock after its successful completion. 
The binding energy and RMSD (root-mean-square deviation) 
value for all the conformations obtained is as under in 
Table 2.

The conformation with the lowest energy returned by 
AutoDock is shown below as Figure 1, (Delano) wherein 
Ubiquinone-c-reductase has been shown in ribbon view 
and Carvacrol with lines and atomic spheres respectively3.

Carvacrol binds to ubiquinone-c-reductase at position 264-
267 amino acids namely histidine, proline, aspartic acid, and 
asparagine respectively. The distance measured between 
the Carvacrol and ubiquinone-c-reductase binding cavity 
was 4.1Å, which implies the strong interaction showed in 
Figure 2.

Discussion
In the present study, the biological activity of Carvacrol 
was predicted and its potential as an anti-malarial drug 
was compared with the components of the commercially 
available drug namely, Malarone. Malarone comprises 
Atovaquone/ Proguanil combination which retards the 
growth of parasite by inhibiting the activity of Ubiquinol-c-
reductase in host red blood cells. Ubiquinol-cytochrome-c 
reductase is one of the three major enzymes involved in 
ETC Pathway, playing a crucial role in synthesizing ATP from 
ADP with the help of ATP synthase. Ubiquinol-cytochrome-c 
reductase catalyzes Fe-S protein reduction reaction and 
thus transfers an electron to cytochrome c.12

Atovaquone showed Pa value 0.775 (where Pa value is the 
probability of the compound being active for a specific 
activity) as Ubiquinol-c-reductase inhibitor which is less than 
the Pa value of Carvacrol (Pa value=0.931). The obtained 
data revealed that the Carvacrol inhibits the activity of 
Ubiquinol-cytochrome-c reductase more effectively as 
compared to Atovaquone with Pa value of 0.931 which is 
also the target receptor of commercialized drug Malarone.

It is a well-known fact that the lower binding energy leads 
to better binding and if binding energy value is negative 
that means binding is spontaneous and does not require 
any energy for the binding to take place, therefore, the 
conformation with most negative binding energy/ affinity 
will be the most preferable conformation when we opt 
to choose the best conformation on the basis of binding 
energy/ affinity. Results indicate that the conformation 
with the minimum binding energy (-5.4 Kcal/ mol) is the 
most preferable out of all conformations of Ubiquinone-c-
reductase docked with Carvacrol. We also predicted that 
Carvacrol acts as a non-competitive inhibitor of cytochrome-
c-reductase which binds at the A chain of the enzyme 
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without interrupting the binding of ubiquinone. Therefore, 
this study shows that Carvacrol can be used as an anti-
malarial drug as a substitute to Atovaquone in combination 
with Proguanil as antimalarial drug.

The above result of biological prediction and docking 
reveals that the Carvacrol binds effectively with Ubiquinol-c-
reductase and thereby can work as an Ubiquinol-c-reductase 
inhibitor of parasite P. falciparum and ultimately retards 
the growth of the parasite. 

Conclusion
Antimalarial drug Malarone, a combination of Atovaquone/
Proguanil interferes with the growth of the parasite in red 
blood cells of the host organism by inhibiting the activity of 
Ubiquinol-cytochrome-c-reductase. The biological activity of 
Atovaquone and Carvacrol was studied using the way2drug 
tool. The result showed that Carvacrol acts as an effective 
inhibitor of Ubiquinol cytochrome c reductase as compared 
to Atovaquone. To confirm the above findings, we have 
performed docking studies by using Autodock 4. The result 
suggests consistency with our findings.
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